NET CONFERENCING

Reserved Net Conference with
Cisco WebEx Event Center
Frequently Asked Questions

This document addresses how to use Reserved Net Conference with Cisco WebEx Event Center service — from scheduling a
Reservation, to confirming or changing a reservation and ultimately to hosting an event.

1. How do | obtain a Manage My Meetings account?

Follow the steps below to register and begin using today!
e Goto https://www.mymeetings.com/custom/site/mymeetings/index.jsp

e  Click on Register for audio/net/video
Click Yes to proceed.
e  Create your leader profile:
Select a login name
Select a password or let the system create one for you
Set a security question and answer
Complete the fields on the page with your information details
Authorization code: your conference administrator will provide this to you
Click Proceed
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* Please Note: if you are a meeting participant logaing on to join or RSP to an event, you wil need the Conference ID and Passcode provided by your
event host. If you have problems when you RSWP or join, please contact your event host dirsctly.

e —
How do | schedule a call?

You will need to schedule the Reserved Net conference with a Premier or Standard audio conference, via either
the Conferencing Scheduling Assistant (CSA) tool or by calling Reservations.

e Conferencing Scheduling Assistant:
o Goto https://www.mymeetings.com
0 Goto Leader Tools and click on Conferencing Scheduling Assistant
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o Follow the instructions within Conferencing Scheduling Assistant
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e Calling Reservations
o https://www.mymeetings.com/custom/res/content/resNumbers.php
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3. Confirmation Email

e Once the leader schedules the meeting, they will receive an email confirmation with the details of the event
which they can share with their participants.
e  Sample Reserved Net Email Confirmation:
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Confirmation email continued

Message
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From: norepliesplease @mymeetings.com Sent: Fri#/21/2015 11:45 PM
To: Parker, Katharine L
(=3
Subject Conference Details (AUG 22, 2015-12:15 AM CT--Conf# 5166010)
For Participants: %
URL: https:/iwww mymeetings com/nc/join/ "
Conference number: PWXW5166010
Audience passcode: SATEST
Participants can join the event directly at:
https {fwww. join php?i=PWXW51660108p=SATEST&t=c
To access the Net replays of this call, all parties may join at
https:/fwww. i join. php?i=PWXW51660108 p=SATEST&t=r
The replay will be available for 30 days, ending SEP-21-2015
NOTE: The replay of this conference is available in an Advanced Recording File (ARF) format and requires the
WebEx Recording Player to be viewed. The Player is available from the Conferencing portal under Leader Tools
~>-Net Conferencing Plug-ns.
To access the Net Participant List for this event, please go to self service reports and then complete the following:
1. Enter your Manage My Meetings Login and Password
2 Select ‘Participant List Reports' from the Self-Service Reports page
3. Select the report you wish to display — Net Conference - and select 'View Report’
4. You can then download or print your report L
Mote: The information presented is listed just as the participants entered it into the various fields, when joining
conference.
For enhanced security and to avoid i billing post: i please di; all participants at the end of
the net conference by selecting "End Event" under the “File” menu
Instant Replay Plus Information:
Replays are general ailable one hour after a call ends.
End date: AUG-23-15 12:01 AM (CT)
Phone: Tfree:800-879-1270
Features  VOICE CAPTURE
Selected Conference Features:
Aud =4

norepliesplease@mymeetings.com




Confirmation email continued:

Transcription Information:

E-mail: MEL.KRAN@XXX.COM
Conference Language: ENGLISH

Email Turnaround Time: 48 hr
*Transcription will be in the conference language.

Meeting Manager Information:

A Meeting Manager will contact you shortly to discuss the details of your call. If you have requested a particular Meeting
Manager, we will do our best to accommodate your needs. Unfortunately, special requests cannot always be granted
due to conflicting meeting times.

Participant List Information:

Send To: VERIZON TESTMK

Conference Coordinator Will Capture: NAME

Comment:

'We make every effort to compile accurate information for each participant. Occasionally, names may be misspelled if
participants speak too quickly or if there is an unclear connection.

Meeting View Leader Access:

To join the event:
https://meetingview.mymeetings.com/MeetingView/login.jsp?customHeader=mymeetings&sigKey=vcpdemo
Conference Number: 164XXXX

You may log onto Meeting View 20 minutes prior to the start of your conference.

For assistance contact your Meeting Manger.

A cancellation fee will be assessed per reserved line, in the event that the conference is not cancelled within 30 minutes
prior to the scheduled start time.

An overbooking fee will be assessed for each unused, reserved line after the first 50 unused lines, per completed
conference. There will be no fee assessed for the first 50 unused, reserved lines.

Leaders can schedule, modify or cancel a reservation by using the Conferencing Scheduling Assistant, an online
scheduling tool. To reschedule or cancel this reservation, go to

https://www.mymeetings.com/confassist/calist?customHeader=mymeetings&sigkey=vcpdemo.

For additional assistance, contact customer service at 800-475-5000
Special notes:

Call notes: JUN-24-13 01:22 PM/CT KRANIGM USA...this is for testing purposes only this call will not take place

The Conferencing Center would like to send you e-mail notes to keep you informed of new or enhanced products and
services, conferencing tips, or special offers, etc.

If you would prefer not to receive these messages, you may unsubscribe now at
https://www.mymeetings.com/custom/redirect.jsp?sigkey=vcpdemo&referer=/emeet/remove.jsp. Thank you.

Do I need to download software to my PC to attend the Reserved Net Conference?

Yes, as you join a Reserved Net Conference, the Event Center Meeting Manager software will load on your PC.
If you wish to download the software prior to joining the call please go to the Plug-Ins page of MyMeetings to
download the Event Center Meeting Manager software. You may also test that it loaded correctly by clicking on
the Setup link under the Event Center section.

Note: If you do not have administrative rights to your PC, the Event Center Meeting Manager software will need to be
downloaded by your company’s IT organization. They may obtain access to the software on the Plug-Ins page.

e  Go to the Plug-Ins page on MyMeetings:
0 https://lwww.mymeetings.com/emeet/join/src/plugins_mm.php?langKey=/en&sigKey=m
ymeetings
Scroll down to the WebEx Event Manager under the WebEx Plug-Ins
e  Choose which version of the Event Center software to load on your PC based on your operating system
Click Setup which will launch you into a test Event Center session if the software load was successful

wWebEx Plug-Ins
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WebEx Event Manager

To start or join an event you will need to download, install, and configure the WebEx Event
Manager. The first time you join or start an event, the Event Manager will automatically be
installed; however you can manually download it here.

Notes:

o If you are using a nen-Windows or Macintosh operating system or browser other than
Internet Explorer or Firefox, a Java Client will be downloaded automatically when you join an
event. For more information, go to the FAQs.

o You must have administrator privileges on your computer to use this installer.

Download the installer for your operating system:
] Event Manager for Internet Explorer in Windows

] Event Manager for Firefox or Chrome browsers in Windows

. Event Center application for Mac 0S X ({Intel)

o Setup
Although WebEx Event Center will automatically be set up when you host/join a mesting,
you can save time by setting up WebEx Event Center, on Windows or Mac, before the
meeting.

W

®100% ~

5. Where will | access the event?

Note: You will need access to Manage My Meetings to use Reserved Net Conference with Cisco WebEx Event
Center. If you do not have access to Manage My Meeting, you should continue to use Reserved Net Conference

Email invitation:
o Participants:

=  The Reserved Net Confirmation email will be sent to the leader of the event who will forward
the invitation to all participants. The participant link to the Reserved Net meeting will be
included in that invitation. Audio details will also be included for participants to dial into the

audio bridge.
o0 Leaders:

= Leaders will log into their Manage My Meetings account to start their Reserved Net
Conference for Cisco WebEx Event Center meeting.
=  The Reserved Net meetings will be listed under the tab for Reserved Calls. See instructions

under the next MyMeetings sub-bullet.

MyMeetings: The meeting link will also be listed on the leader’'s Manage My Meetings account on the

Reserved Calls tab

o Goto https://www.mymeetings.com/custom/site/mymeetings/index.jsp
o Enter your login and password. (Note: If you do not have a Manage My Meetings login and password,
Click on the Need to Register link and simply follow the instructions.)

o Select the Reserved Calls tab.

o Locate the appropriate confirmation number for the conference.

o Select the arrow icon to initiate the conference.

with Microsoft Live Meeting for the short term.

6. Is there a cancellation policy?

Yes, Reserved Net calls may be cancelled up to 30 minutes before the event without incurring a cancellation
fee. If canceled within 30 minutes of the scheduled start time, a cancellation fee may be assessed.

7. Can my call be recorded?

Yes, you may request the call to be recorded. For each call that is

this time, there is extra charge for each additional 30 day period.

The Net Replay will be available after the call via the link included in the Reserved Net email confirmation.
You may also request an FTP File Download of the recording for an additional fee. The link to the FTP File

download will be included in an email sent to you after your call.

8. Is software required to view the replay of the meeting?

Yes, the replay and the FTP file Download are both available in an

under Leader Tools and then Net Conferencing Plug-Ins.

recorded, there is a setup fee that
includes storage of the recording for 30 days. If you'd like to maintain the availability of the recording after

Advanced Recording File (ARF) format
and require the WebEx Recording Player to be viewed. The Player is available from the Conferencing portal
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How do | retrieve the recorded file from my Reserved Net call?

e  The host of the call will receive the below email
e  The “From” field will come from the person who hosted the meeting.

Cc
Subject: Instructions for downloading the WebEx FTP recording "PWXW5166010-20150822 0445-1"

Please follow the instructions below to download the FTP recording from your recent WebEx Reserved Met
conference.

PWXWS5166010-20150822 0448-1
Auqust 22, 2015, 12:48 pm Taipei Time
5 mins

DOWNLOAD INSTRUCTIONS:

1. Click on the link below, or if your email program does not allow linking, copy and paste the link into the address
field of your Internet browser:

https: //resnetl.webex.com/resnetl/lsr.php?RCID=b2efl3ad6f4ef54f5b3ediib410aalSc

2. Once you have been redirected to the Download page, select the "Download” button.

3. When given the option to "Open” or "Save” the file; select the arrow next to the "Save” button, then select "Save
As".

4. Once the "Save As" window appears, choose the location where you'd like to save the FTP file and select the
"Save" button.

** Please download your FTP recording within 30 days of the date of this email, after that time it will be deleted
off the server and no recording backup is maintained past this time frame. **

If you need assistance, please contact us at the following email address: conf@mymeetings.com

» [0

NeoRepliesPlease@mymeetings.com

e  Click the link provided in the email as seen in the below screen shot.

I want to share the following WebEx recording with you. Click the link below to play it:

https://resnet-dev.webex. com/resnet-dev/lsr. php?
AT=pb&SP=ECArID=539



https://www.mymeetings.com/emeet/join/src/plugins_mm.php?sigKey=mymeetings�

Note: If you choose to Playback the recording, you may still Download the recording at a later timeframe.

6 =2 ‘) https.//resnetl.we.. O ~ @ & U Recording Information

File Edit View Favorites Tools Help

B~ v [ @m v Pagev Safety~ Toolsv @~

Recording Information
Topic: PWX\W4925204-20150826 1356-1
Recording date: Wednesday, August 26, 2015 10:15 am
Eastern Daylight Time (New York, GMT-04:00)
Panelist Information:
Duration: 1 hour 25 minutes
Description: Downloadable Recerding

©2015 MyMeetings
Privacy | Terms of Service | Reguest information about WebEx services

e  After selecting "Download” the following page will appear and you will have the ability to “Save” the file in a
location of their choosing.

L MIE ) https//resnetlwe.. O ~ @ & | @) Download file
File Edit View Favorites Tools Help
@ - * [ @ ~ Page~ Safetyv Toolsw |@|v
Download file:PWXW4925204-20150826 1356-1.arf
The recording file is ready for downloading now.

Note: The WebEx ARF player is required to playback the recording. Download ARF player

Close Window

If you do not have the ARF player installed,
you may click the “download” link to install it.

©2015 MyMeetings

Privacy | Terms of Service | Request information about WebEx services

PWXW4925204-20150826 1356-1.arf (41.6 MB) ntalwss.webex.com

Open Save v Cancel

10. How can | convert the recorded file to a different format?

e  The FTP recording will be downloaded in an Advanced Recording File (ARF) format that is WebEx
proprietary software which will require the user to install the WebEx Player to view the recording.

e You may convert the recording to one of the following formats:
o .WMV - Windows Media Video
0 .SWF - Macromedia Flash Format
0 .MP4 - MPEG Audio Layer



e This is a Real Time conversion process: A presentation with a duration of 1 hour and 15 minutes will take 1
hour and 15 minutes to convert.

e Inthe Network Recording Player select File
e  Select Convert Format
e  Select either WMV, SWF or MP4

View Info Help

Open Ctrl+0 }62 | Date: Wednesday, August 26, 2015 | Time

WMV (Windows Media)...

Close Ctrl+W SWF (Flash]...
MP4 (MPEG-4)...

Exit Ctrl+ )
Miednesday, August 26, 2015
Time: 9:18 AM, Local Time (GMT -05:00)
l Host: Conference Admin

The Convert to window appears.
e Select OK to proceed to start the conversion.

¥ideo Codec
Video Codec: | Windows Medsa Video 9 =]
Audo Codec
Audio Codec: | Windows Media Audic 9.2 [~]
Conversion Stark Time

It may taks a subctantial amount of time and vour computer rescurces o corwert this fila,
When do you plan to start the conversion?

¥ Corvert now
" Corwert at a scheduled bme:

pema]][z0 [S][12 [#]  [1s [=H s [#]

The conversion requires Windows Media Player 9.0 or ahove.

e  The below message will appear.
Select OK and this message will disappear, leaving the conversion process to run in the back ground as you
work on other things.
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Metwork Recording Player

Conversion of "Cther Teleconference Test-20110815 1542-1,arf" to "Other Teleconference Test-20110515 1542-1.wmy",
Double-click the Conversion Manager icon on the taskbar of wour deskiop ko view information about and manage scheduled
recording conversions,

e You may check the conversion progress by placing your mouse over the following icon in at bottom-right of
your screen (system tray):

converking: 10% converted

11. Is operator assistance available to me during my conference?

e Before the event:
Yes, operator assisted services are listed under Net Feature Support on the scheduling systems.

(0}

This feature allows you to request a Net Conferencing Specialist to provide event support

services during a Net Conferencing session on your behalf.

An additional charge applies per session per Event Support service. Examples of Event

Support Services include:

< Video playback: Assistance and coordination of the video playback to allow the audio to
play through the audio conference.

< Advancing slides: Advancement of the slides on behalf of the leader.

< Closed Captioning: Coordination of closed captioning for the event.

e During the event:
0 The operator will attend a Premier Level Audio conference for the entire time to attend to Q&A, or
address issues during the call.
0 The leader will enter *0 to have the operator rejoin the audio conference to attend to an issue.

e After the event:
0 Charges for Operator Hosting services will be included on your invoice for the call.

12. How many participants may | have for my event?

e  Up to 3,000 participants (including the presenter and the event operator)are supported on Reserved Net
Conference for Cisco WebEx Event Center.
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13. What is the WebEx Event Center Leader Console?

The console is an easy interface that makes controlling a meeting very intuitive. Leaders can select to have
only those windows that are most important to them open during the meeting, showing the participants, chat,

notes, or video. Simple tabs make it easy to flip from presentation to presentation.

Toolbar Particinant | ist

Chat

Recorder

i Cisco WebEx Event Center

File Edit Share View Communicate Participant Event Help

¥ Chat

Quick Start Event Info Paﬁc\p;ts
¥ Participants (1)
T29 ¥ Panelists: 1
EvaD Host, me
Host: Eva Deneski v Attendees: 0 (0 displayed)
Eve v 746 923 032
® Record End Event

All Participants

Connect to Audio Share Screen Invite & Remind ¥ Recorder
Select button to record an server
soo Copy Event URL
v Q&A
All(0)

hat Send

14. How do | ShareContent in the event?

A best practice for presenting content in a WebEx Event Center session is to use File Share.

() Cisco WebEx Event Center
File Edit View Communicate Participant Event Help
My Screen  Ctri+Alt+D

Quick A File Oncluding Video).. I

Application 3
—l—r- Whiteboard  Ctrl+Alt+N
¥d

Web Content...

Web Browser...

Multimedia...

My Event Window

@ Record End Event

File sharing is ideal for presenting information that you do not need to edit during the event, such as a video or
slide presentation. Participants can view shared files in their content viewers without the need for the application




with which it was created. They may view a media file, such as a video, without the need for special software or
hardware. They can also view any animation and transition effects on shared Microsoft ®PowerPoint ®slides.
After an event starts, you can open a presentation or document to share. You do not need to select it or load it
before the event. However a best practice is to arrive to the call about 15 minutes before the call to initiate the
File Share for any documents you intend to share during the call. They will be arranged in folder across the top of
your meeting for easy selection during the call.

While sharing a file, you can:
e  Draw on the screen
e Use a pointer to emphasize text or graphics
e Printit
e Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
e Synchronize all participants' displays with the display in your content viewer
Save it to a file

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and display
different views of shared content.

Sharing a file
You can share a file, such as a document, presentation, or video that resides on your computer. Participants view
the shared file in their content viewers.

To share a document or presentation:
e  On the Share menu, choose File (Including video). The Share File dialog box appears.
e  Select the file that you want to share.
e  Click Open.

The shared file appears in the content viewer.

Tips for sharing files
These tips can help you share files more effectively.
e Toimport slide presentations quickly:

. Limit the number of animations and slide transitions.

e  Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps
do not compress well.

e Toimprove the speed at which shared pages or slides appear in participant content viewers, save
the document or presentation as a .ucf (Universal Communications Format) file before the event
starts. Then share the .ucf file instead of the document or presentation itself.

e You can annotate shared presentations or documents in the content viewer; however, you cannot
edit them. If you want to edit shared information, you can use application sharing instead.

To save time during an event, begin sharing the document or presentation before the event's starting time. That
way, after participants join the event, they can begin viewing your presentation.

Choosing an import mode for presentation sharing
For Microsoft Windows ®users only

Before you share a presentation, you can choose one of the following import modes:

e Universal Communications Format (UCF)-The default mode. Allows you to display animations and
slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Event Manager imports
presentations more quickly than it does in the printer driver mode. However, pages or slides may not
appear consistently in Event Manager across platforms.

e  Printer driver-Displays shared presentations as they appear when you print them, providing a
consistent appearance of pages and slides in Event Manager across platforms. However, this mode
does not support animations or slide transitions. In this mode, the first page or slide may appear quickly,
but the total import time for all pages or slides is usually longer than it is in the UCF mode.

Note: Changing the import mode does not affect any presentations that you are currently sharing. To apply a
new import mode to a shared presentation, you most close it first, and then share it again.
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To choose an import mode for shared presentations:

In the Event window, on the Event menu, choose Options. The Event Options dialog box appears,

with the Options tab selected by default.
e  Click the Import Mode tab.

(Q Event Options

Communications True Color Mode

ImpDﬂMDde

To ensure good-quality imaging for document and presentation
sharing, select the appropriate import mode,
Import mode:

O Universal Communications Format
Supports animations and slide transitions in shared Microsoft(R)
PowerPaint(R) presentations

Printer driver
Provides better cross-platform imaging, but displays presentations
without animations and slide transitions

oK Cancel

e  Select either Universal Communications Format or Printer driver.

Closing shared files
You can close any files that you are sharing in your content viewer.

To close a shared file:
. In the content viewer, select the tab for the file that you want to close.

e  On the File menu, choose Close.

If you have not yet saved any annotations that you made on the document or presentation, a message appears,
allowing you to save it.
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15. What file types are supported for sharing in Cisco WebEx?

Please see below tor a listing of supported tile types:

. . . File Name
Media Object Supported Media Formats Extensions
WebEx Recording WebEx Recording Format (AWRFY
Audio Windows Media Audio TS

Advanced Streaming Format Asf

Audio for Windows (WAL Ay

ﬂﬁﬁ:gqﬁ%ﬂent Digital mid, midi

Macinbosh AIFF Resource A, .alff

MP3 (MPEG Audio Layer) MmpZ, mpy2, mp3

LIMNTx Audio .au

Sound (SHD) o

Audio Interchange File Aif, .aiff, aifn
Video Windows Media Video T,

Advanced Streaming Format Asf
Audiofideo Irterleave (AW =Vl
Mowing Picture Experts Group mpg, mped, milv,
(MPEG) JORE, e
Video - QuickTime P
movies Q Apple QuickTime Tnmy, gt
Flash movies and

interactive Flash Macromedia Flash format S

Ay URL an the Intemet or vour \For example, hkm,

Web page private intranet asp, hhh

16. How do | share a video as a Presentation or Document?

¢ In the meeting window, go to the Share menu, then select File (Including Video)....
The 'Share Document' window appears.
Navigate to and select the file you would like to share in the meeting.
Click Open.

Notes:
e Avideo file must buffer before it can play back.
e Itis recommended that the video file being shared is no larger than 5mb.

WebEx supports the following video formats as a Presentation or Document share:

flv (FLV files using the VP6 codec are not supported on SP22 or newer sites)
.swf
.asf
wmv
.avi
-mpg
.mpeg
.m1lv
.mpa
.mpe
wm

Required Player

BUilt in
YWindows Media Player

YWindows Media Player

Apple QuickTime Player
for \Windows

Macromedia Flash Player

Intemet Explorer



17. What is the Maximum Recommended Size for a Shared PowerPoint File?

For best results when sharing a PowerPoint file, refer to the following guidelines:

e Do not include more than 20 to 30 slides in one presentation file. If you want to share more slides,
create a separate presentation file for each set of 20 to 30 slides.

o  Keep the size of the presentation file to no more than 5 MB.

e Itis recommended to not share embedded media objects that are larger than 5MB.

Note: You may exceed the 5mb recommendation if the service type used has the ability to stream video files.

18. What is the best method to share a video file in a WebEx meeting?
Follow the steps below to stream a video file in a WebEx meeting:

e  On the Quick Start, click the Share File button.

. If the Quick Start is not visible, go to the Share menu, then select File (Including Video)

¢ Navigate to and select the video file you would like to share and then click the Open button.
e  The video will begin playing in the WebEx meeting.

Notes:
¢ Recommended for sharing video files stored on your computer or a network location.
e  Starts playing for attendees instantly.

The following file types are supported with streaming video sharing:

WMV
WMA
WAV
.MP3
ASF
AVI
.MPG
.MPEG
.MOV
.FLV (Video codec must be H.264, files using the VP6 codec will not playback properly)
.F4Vv
QT*
° .MP4*
*The computer sharing the video must be able to playback the file locally.

19. How do | share avideo from a web site or web page?
Follow the steps below to share Web Content:

In the meeting window, go to the Share menu and then choose Web Content....

The 'Share Web Contents' window appears.

In the Address box, enter the address, or URL, at which the content resides.

Note: If you have previously shared the content, select it in the drop-down list.

In the Type: drop-down menu, select the type of Web content that you want to share.
Click the OK button.

e Tip: You can copy a URL from any source, such as another browser window, and then paste it in the
Address box.

Notes:
e  The video file must be on a publicly accessible web address and not password protected.
e Can also be used to display a web page that contains a video, such as YouTube.
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20.

Which Webcams are supported?

Camera hot-plugging is supported with WebEx HD/HQ video. This means cameras can be plugged in and
detected by WebEx during a live meeting.
IP or web-based cameras are not supported by WebEx. Virtual webcams such as YouCam, ManyCam and
WebCam Splitter are also not supported.
Webcams listed in Microsoft's Hardware Compatibility List (HCL) should work with any WebEXx product that
supports video conferencing. If your device is not listed, it may not work with WebEXx.

Hi-Definition video is not yet supported in Event Center.

Cameras compatible with High Quality Video:

Manufacturer
Cisco ¢
[ )
Tandberg °
[ )
[ )
Logitech °
[ )
[ )
[ )
[ )
Microsoft ¢
[ )
[ )
[ )

Model

Cisco VT Camera |l
Cisco VT Camera lll

Tandberg Precision HD

Logitech Quick Cam Pro 9000
Logitech Quick Cam Orbit AF
Logitech Quick Cam C905
Logitech Quick Cam S7500
Logitech HD Pro Webcam C910

Microsoft LifeCam HD
Microsoft LifeCam VX-1000
Microsoft LifeCam Cinema
Microsoft LifeCam VX-6000
Microsoft LifeCam NX-6000
Microsoft LifeCam VX-3000

Cameras compatible with Standard Quality video:

Most PC-compatible cameras should work with WebEx. The following cameras were tested by WebEx:

Cisco VT Camera Il

Creative WebCam Notebook
Creative WebCam NX Ultra
Creative WebCam PRO
EzpmocsEZCam USB Il

Logitech QuickCam- Notebooks Pro
Logitech QuickCam Zoom

Logitech QuickCam Express

21. Who can share their Webcam in an event?

22.

23.

Logitech ClickSmart310
Logitech QuickCam pro 4000
Logitech QuickCam Messenger
Aiptek VGA+

SUMSUNG S-1298
SUMSUNG S-1288

Microsoft LifeCam NX-6000

Only the host, presenter or a panelist may broadcast their webcam video in an event.
By default, panelists cannot broadcast video in an event. The host must allow a panelist to send video

How Many Video Cameras can be displayed?

The number of video cameras that can be displayed in a session of Event Center is 1.

How does a panelist send video in an event?

The host of the call must follow the steps below to allow a panelist to send video:

In the Participant panel, place your mouse over the large video window, then click the E button.
The 'Panelist Video Options' window appears.
Go to the Allow to Send Video tab.

Check the boxes of the panelists you would like to send video, then click the OK button.



e The selected panelists may now send video by clicking the button.

24. What are the bandwidth requirements for in-meeting video?

WebEXx generally recommends network bandwidth above 1Mbps per participant. A dual-core PC @ 2.0 GHz w/
1GB ram should be used. The minimum network bandwidth to view video should be above 320Kbps per
participant.

Standard WebEXx video generally requires bandwidth between 90-130Kbps per video participant at the default
configuration, which is QCIF resolution (176 x144 pixel) at 15fps.

Bandwidth requirements for High Quality (HQ) video are as follows:
e  High Quality - 360p (640x360) - Up to 1.5 Mbps of your internet connection will be used when sending video

e  Standard Quality - 180p (320x180) - Up to .5 Mbps of your internet connection will be used when sending
video.

Note: The figures above are only for webcam video and do not include any other in-meeting activities. You
will need to additional bandwidth to use desktop sharing, integrated VolP, etc.
25. Q&A
Questions can be answered publicly or privately in a Q&A session.
Providing a public answer to a question:
e Onyour Q&A panel and click on the question.
e A number will be displayed in the tab the question was received in.
v Q&A X

All (1)

): This is a question

Public Response

Send Send Privately...

Send Connected @

e  Type your answer into the text box and click the Send button or press enter.
The answer will appear on all panelists' and attendees' Q&A panel.

Providing a private answer to a question:
¢ Go to the tab the question was received in, and click on the question.

¥ Q&A X

All (1)

Q: This is a question

Private Response

Send Send Privately...

¢  Type your response, and click the Send Privately... button.
e«  The answer will only be sent to the attendee that asked the question.

Responding to questions answered verbally:
e Right-click on the question in the Q&A panel.
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e Select Answered Verbally from the context menu.

Answering indicator
When a panelist is typing an answer to a question that hasn't been responded to yet, an in-progress indicator will
display below the question for all participants. See the example below:

TQ&A

X

All 1] My Q&A (1)

: This i= a question
This guestion is being answered...

26. Saving a Q&A session

At any time during a session, you can save the questions and answers on the All tab on your Q & A panel to a .txt
or .csv file.

In the Session window, on the File menu, choose Save>Questions and Answers.

The Save Questions and Answers As dialog box appears.

Choose a location at which to save the file.

Type a name for the file.

In the Save as type box, select Text Files(*.txt) or CSV (comma-separated/comma-delimited values).

Click Save.

27. Who can present during the Event?
Your event production team can be broken down into the following roles:

Role | Description

Host The participant who schedules, starts, manages, and ends the event and designates the presenter,
panelists, and polling coordinator.

The event host initially is the presenter. After the invited panelists join the event, the host can pass the
presenter control to any of the panelists at anytime during the event.

Presenter

The participant, with the presenter control symbol ,who is responsible for sharing and presenting
information during the event.

Panelist | A participant who is primarily responsible for assisting the presenter and participating in presentation.

Attendee [ A participant who mainly listens or watches and does not present information during the event.

28. What can each role perform during the event?
e Hosts can do the following:
A host is responsible for coordinating and controlling an event. Only one person can be an event host at
atime.
0  Schedule and start an event
Start and end a practice session among the panelists
Invite attendees to a scheduled event
Invite attendees to an event in progress
Grant privileges to attendees or panelists during an event
Designate a presenter
Assign the host role to another panelist, and reclaim the host role
Answer attendees' questions during a question-and-answer (Q & A) session
Restrict access to an event
Specify or edit a greeting or message for attendees during an event
Act as poll coordinator to start a poll
Pass the poll coordinator role to another panelist
Record an event

O0OO0OO0OO0OO0OO0OO0OOOOO



o Endan event
Note: Once an event starts, the host is initially the presenter as well. The host can then designate another
participant to be the presenter.

e Presenter can do the following:
An event host can designate any attendee as a presenter. A presenter is responsible for providing
content during an event.
Documents, presentations, and whiteboards
Save documents, presentations, and whiteboards in the content viewer
Share applications, Web browsers, and desktops
Share multimedia Web content
Take a poll if the host passes the poll coordinator role to the presenter
Save a poll questionnaire and poll results to a file
Answer attendees' questions during a question-and-answer (Q & A) session
Send text responses to attendees' questions on the Q & A tab
Participate in a practice session
Participate in a chat
Save chat messages to a file
Save a Q & A session to a file
Record an event

O0O0O0O0OO0OO0OO0OO0OO0OO0OO0OO

e Panelists can do the following:
A host can designate any attendee as a panelist during an event. A panelist is a participant who is
primarily responsible for assisting the presenter and participating in presentation. Any number of
attendees can be panelists.

O Participate in discussions to which other attendees listen

O Respond to public and private chat messages

O  Annotate shared documents

O  Start a poll if the host passes the poll coordinator role to the panelist

O View and answer attendees' questions in a Q & A session

O View poll results

O Annotate shared applications, Web browsers, and desktops, if the presenter grants annotation control to
the panelist

O Participate in a practice session

O Save chat messages to a file

O Download files that the presenter publishes

O View live video that the presenter sends

O View feedback

O Record an event

e Attendees can do the following:
An event attendee participates in an event, but generally does not present information.
View shared documents, presentations, and whiteboards in the content viewer
View shared applications, Web browsers, and desktops
View shared multimedia Web content
Participate in a poll
Participate in a chat
Save chat messages to a file
Download files that the presenter publishes
View live video that the presenter sends

O0OO0OO0OO0O0OO0OO

e |f the event host or presenter grants the appropriate privileges to attendees, an attendee can also:
Annotate shared documents and presentations in the content viewer

Write and draw on shared whiteboards in the content viewer

Save documents, presentations, and whiteboards in the content viewer

Annotate shared applications, Web browsers, or desktops, if the presenter grants annotation control to
the attendee

Copy and paste pages, slides, and whiteboards in the content viewer

Display different views of pages, slides, and whiteboards in the content viewer - for example, full-screen
view or thumbnail (miniature) view

O  Print shared pages, slides, or whiteboards in the content viewer

O Record an event

O0O0O0

[e}e)

e  Polling Coordinators can prepare a poll questionnaire and conduct a poll during the event.
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29. How do | use Polling during an Event?

Polling enables the Leader to utilize the operator to survey all conference participants. You determine the
questions prior to the conference and participants respond using their telephone keypads. Polling allows you to
collect instant feedback and increases participants’ involvement in the call. You receive a report with all
responses that is organized by question and participant. The poll coordinator is responsible for creating

and conducting the poll during the event. The host can assign the role of poll coordinator to a presenter or

a panelist.

How Do | Open a Poll
After you finish preparing a poll questionnaire, you can open the poll.
If you prepared your questionnaire in advance and saved it, you must first display it on the Polling panel.

In the event window, go to the View menu, then select Panels>Manage Panels....

The 'Manage Panels' window appears.

In the Available panels: section, select Polling, then click the Add >> button.

Click the OK button.

In the Question section in the Polling panel, select the type of question you would like to add, if the question
will have a single or multiple answer, then click the New button.

Note: You may open a previously saved poll by clicking the C button and selecting the poll.

Type out your questions and answers. Repeat to add multiple questions to the poll.

Click the Open Poll button.

The questionnaire appears on attendees' Polling panels. Attendees can now answer the poll.
As attendees answer the questions, you can watch the polling status on your Polling panel.

Poliing status

Not started s s T2
i ————— _____ Tovieweachatiendee’s
In progress e —  ———  poling status, click one of

Finished A=er N 1hese three buttons.

Remaning fime: 454  Tmelmt 1000

Click Close Poll when the time is up.

If you specify a timer and the poll times out, the poll automatically closes.

Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with attendees.

Preparing a Poll Questionnaire - Presenter only

To conduct a poll, you must first create a poll questionnaire. You create a questionnaire in a meeting. To save
time during a meeting, you can start the meeting earlier than the scheduled time, create a questionnaire on the
Polling panel, save it, and then open it during the actual meeting.

This figure shows a portion of the Polling panel, which offers the tools you can use to create a questionnaire.

© Multiple choice Single Answer -
Short answer

Mew

Record individual responses

Follow the steps below to create a questionnaire:
e  Open the Polling panel in a meeting.
¢ Inthe Question section, select one of these question types:
o To create a multiple-answer question, select Multiple choice, and then select Multiple Answers in the
drop-down list.
o To create a single-answer question, select Multiple choice, and then select Single Answer in the drop-

down list.
o To create a text question, select Short answer.
Click New.

Type a question in the box that appears.

In the Answer section, click Add.

Type an answer in the box that appears.

To type another answer, click Add once you finish typing an answer.



e The question and answers appear in the Poll Questions area.
This figure shows an example of a poll questionnaire.

¥ Polling X

Time elapsed:  0:46  Time limit:  5:00
Poll Questions:

ltest
as
b.f

cg
dh

Submit

Your answer may be recorded.

Note: The character limit for the polling question & answer fields are 250 characters.
30. How do | end the Event?
e  The Host will End the Event by clicking on End Event under the File menu.

Cisco WebEx Event Center
Edit Share View Communicate Participant Event Help

Open and Share... Ctrl+0

Open Poll Questions...
Open Chat...

Open Questions and Answers...

Save 3
Save fAs »
Transfer... Ctrl+T
Print 3
End Event

31. How can | obtain a list of Participants who joined my Event?

The link to your Reserved Net participant list can be found in the Reserved Net email confirmation.
However you may also follow the instructions below.

e Log into Manage My Meetings
e Usethe Leader Tools and Self Service Reports link
0 Click Leader Tools in your Manage My Meetings account and select Participant List
Reports
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MyMeetings

Conferencing Solutions

Conferencing Leader Tools

M Conference Scheduling Assistant
Web Moderator

P» Conferencing Reporting

M Mobile Conference Connection

M Meeting View

P» Collaboration Plug-ing

M Net Conferencing Plug-ins

3 I Alert

M» Participant list reporis I

Note: Access to some tools requires a Manage My Meetings® account.

EEEILI== o

Conference Scheduling Assistant

Web Moderator

Conferencing Reporting

Mobile Conference Connect

Meeting View

Collaboration Plug-ing

MNet Conferencing Plug-ins

1M Alert

Web RSVP reports

Logout

Participant list reports

o Enter the Conference ID or Meeting Number and click Proceed

MyMeetings

Conferencing Solutions

Participants List
Conferenced: [ |

Back to Manage My Meetings

EEEIIE .

L t

oqoul

0 Choose Net Conference and Click View Report

Participants List

ContactUs | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the
lcomma separated (CSV) file to your local application (e.g. Excel, Lotus
Notes).

Conference ID 128

Leader: ASHI
Date/Time: JUL-28-2013 04:00 PMET
Duration: 30 mins

Choose the report(s) that you wish to view.
Y'ou may sort the entries by clicking on the column header.

Select Report(s) To
Display

|1 Net Conference

[] Net Replay

Download/Print your
report

[? Helo

O Report will display the people who viewed your Net Conference.
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Participants List

Date/Time: JUL-28-2013 04:00 PM ET

Duration: 30 mins

You may sort the entries by clicking on the column header.
Net Conference Total Participants: 5

ASHE -UAT R VERIZON BUSINESS 07/28/2013 03:19 PM  ASHE

ashe part R VZn 07/28/2013 03:20 PM  z@b.com
ashe part2 R VZn 07/28/2013 03:21 PM  a@b.com
ashe part3 R vZn 07/28/2013 03:23 PM  z@b.com
ashe part3 R VZn 07/28/2013 03:42 PM  z@b.com

Grand Total: &

Contact Us | Manage My Meetings | Conferencing Home

Mote: You may format and analyze the entire data file by downloading the Select Report(s) To || Download/Print your

comma separated (CSV) file to your local application (2.g. Excel, Lotus Display report

Notes). [Z] Net Conference C8Vitext version
[7] Net Replay L3 printer Friendly

Conference ID 128 [viewrenen ] |21 e

Leader: ASHE

omsruae Juasruoe coway 1|~ omprmue

Note: Participant list names will appear as entered by the participants when joining the conference.

32. How can | obtain a list of Viewers who viewed the Replay of my meeting?

e Log into Manage My Meetings

e Click Leader Tools in your Manage My Meetings account and select Participant List Reports

MyMeetings

Conferencing Salutions

EEII™ .

I N T T

Conferencing Leader Tools

Note: Access to some tools requires a Manage My Meetings™ account.

M Conference Scheduling Assistant

M Web Moderator

M Conferencing Reporting

Leader Tools
Conference Scheduli t  Logout

Web Moderator
Conferencing Reporting
Mobile Conference Connect
Meeting View
Collaboration Plug-ing

Net Conferencing Plug-ins

M Mobile Conference Connection
P Meeting View IM Alert
M Coliaboration Plug-ing

Web RSVP reports

pp Net Conferencing Plug-ins

Participant list reports

pp 1M Alert

M Web RSVP reports

e Enter the Conference ID or Meeting Number and click Proceed

MyMeetings

Canferencing Solutions

Participants List
ConferencelD: [ |

Back to Manage My Meetings

EEEII®™ e




e Choose Net Replay and Click View Report

Participants List

Contact Us | Manage My Meetings | Conferencing Home

MNote: You may format and analyze the entire data file by downloading the

lcomma separated (CSV) file to your local application (e.g. Excel, Lotus z

Notes). Select I_%epo;l{s} To Dawnload!P:ntyour
[ lNetConferancal 7

Conference ID 128 Help

[7] Met Replay

Leader: ASHI ‘ View Report i

Date/Time: JUL-28-2013 04:00 PM ET
Duration: 30 mins

Choose the report(s) that you wish to view.
You may sort the entries by clicking on the column header.

e Report will display the people who viewed your Replay.

Contact Us | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the comma separated (CSV) file to your local application (2.g
Excel. Lotus Notes)

Conference ID 128

Leader: ASHE

Date/Time: JUL-28-2013 04:00 PM ET

Duration: 30 mins

You may sort the entries by clicking on the column header

Net Replay Total Participants: 1

EIRSTHAME [LASTNAME |cOuPANY |TILE | jomwpatemmE |EMAL
R Vzn

MAIL
Ashe 07/29/2013 01:21 PM a@b.com
Grand Total: 1

Note: Participant list names will appear as entered by the participants when joining the conference.
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